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Introduction

FileZ is a general system utility program for Palm OS developed by nosleep software.  It was
originally written in spring of 2000 and has continually been improved since then.  FileZ is
completely free (and the source code is available under the Gnu Public License).  This is
because we feel that some high-fidelity software should be available to anyone.

Every new feature ever added to FileZ has been at the request of our users, so if you have a
suggestion on how to make FileZ better, be sure to let us know.  Also, if you have any problems
using FileZ, feel free to fill out a support request (the response time varies, but we do respond to
every request).  To make a suggestion or ask for help, and to find the latest news about current
and upcoming apps, be sure to check out www.nosleep.net.

What it Does

FileZ is a general system utility program for Palm OS that provides 3 things: file management,
general system information, and system preference management.  The file manager provides
access to the complete file listing on both internal and external memory cards.  Detailed
information about each file can be viewed and edited.  In addition, files themselves can be
viewed and edited directly.  The general system information that FileZ provides consists of
device, battery, and HotSync information.  The system preference manager allows preferences
to be viewed and removed.

System Requirements

Palm OS 3.0 or higher with about 150k of free memory.
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How To Use

When you start FileZ for the first time, you will see the main
menu screen.  From here you can choose to view the file
manager, system information, or the preference editor.
The memory card can be chosen in the top-right corner of
the screen.  General battery and memory information is
shown at the bottom.

Try: You can tap on the memory and battery bars to
change how that information is displayed.

The File Manager

When you choose the File Manager, you will be presented with a list of all the files on the
current memory card (changeable in the top-right of the screen).  You can view the details of
any file by selecting a file (by tapping on it), and then tapping the Details button.  You can view
and edit any file on the internal memory card by selecting a file, and choosing the “Edit File”
menu item (you can display the menu by tapping on the Menu button down by the graffiti area).
You can filter the file list to only show certain files, such as only those files that have filenames

that begin with the letter A, by tapping the Filter button.

The file list contains two columns, the first column is always
the file name.  The second column can show a variety of
information about the files.  You can change what is shown
in the second column by tapping on the triangle next to the
second column name.

Try: You can change the order of the files in the list by
tapping on the column names (e.g. Filename or Creator).

If you have a color device, you can assign different file types
to appear as different colors in the list.  You can do this by
choosing Set Type Colors in the Options menu.

If the ROM box is checked, then the built-in read-only files will be shown in the list.  You can
export the current file listing to the Memo Pad application by choosing “Send to Memo” from the
menu when viewing the file list.  You can quickly jump around in the list by writing a letter in the
graffiti area (e.g. if you graffiti an f then the list will scroll down to the first file with a filename that
begins with the letter f).

Three file attributes are shown in the list as icons: the chip icon indicates that the file is located
in the read-only memory of the device, the lock icon indicates that the file is copy-protected and
cannot be beamed via IR, and the double-document icon indicates that the file will be backed up
to the desktop on the next sync.

When showing attributes: r – resource DB, o – read only, a – app info dirty, i – ok to install
newer, e – reset after install, s – stream, p – open db
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File Details

You can find out more information about a file by selecting a
file and tapping the Details button.  The file info is organized
into three tabs: General, Attributes, and Dates.  General
shows basic file info, Attributes shows the various flags
associated with files, and Dates shows the dates the file was
created, modified, and last backed up on.  Note that less
extensive information is available for files located on external
memory cards.  You really should never need to change any
of the attributes of a file, so don’t (unless you know exactly
what you are doing and have a really good reason to do so).

The Filter Feature

You can filter the list of files that appear based on different
characteristics of the files such as the file name, size, etc.  To
do this, tap the Filter button and then choose the filter criteria
and the value.  You can then turn off the filter by tapping on
the Unfilter button.

The File Editor

You can edit files using the built-in hex editor by tapping on a
file and choosing “Edit” from the menu.  WARNING: editing
files can permanently damage files.  Only edit files if you
know exactly what you are doing.
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System Information Viewer

Tap the Information button to view general, battery, and
Hotsync information about the device.

The Preference Editor

Palm applications typically save a small amount of
information in a special system file.  This is usually
information about the user’s preferences for an application
(for example, whether a list is sorted in alphabetical or
reverse-alphabetical order).  The format for this information is
application-defined, so it can only be viewed as raw bytes.
DO NOT delete any preference records unless you know
exactly what you are doing.
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Frequently Asked Questions

Q: What external memory cards are supported by FileZ?

A: FileZ supports any external memory card that uses the VFS file system.  These include
Secure Digital (SD), Multimedia Cards (MMC), Compact Flash (CF) and Sony Memory Stick
external cards.  FileZ also has limited support for the SFS file system on MemPlug cards.

Q: How do I move or copy files?

A: To move or copy a file, just select the files to move or copy, tap the Menu button, select the
File menu, and then select Move or Copy.  You can perform the following moves/copies:

• From internal memory  to external vfs card
• From external vfs card to internal memory
• From external vfs card to external vfs card
• From external sfs card to external sfs card

Q: How do I backup files?

A: Note that FileZ is not designed to be a backup tool.  There are many other programs
designed specifically for the purpose of backing up.  But, you can mark files so that they will be
backed up the next time you sync.  This basically means that when you sync, a copy of the file
will be made on your desktop computer (in the user’s Backup folder).  Then, if that file is ever
missing from your handheld (from a hard reset or if you delete it) then the next time you sync it
will be restored onto your handheld.  Please note that once you mark a file to backup, the only
way to prevent it from being copied back to your handheld in the future is to delete the file from
the Backup folder on your desktop.  Simply unmarking it will not prevent it from being restored to
your handheld in the future.

To mark a file to be backed up, just select a file, tap the Details button, tap the Attributes tab,
and check the Backup box.

Q: How do I beam files?

A: You can beam files in two ways.  You can either tap a file and then tap the Details button,
and then tap the Beam button.  Or, you can tap a file, tap the Menu button, select the File menu,
and select Beam.

A: How do I edit files?

A: FileZ allows database files located on the internal memory card to be directly edited.  This is
a byte-level editing ability.  It is not a replacement for a text editor.  Unless you know exactly
what you are doing, editing files using FileZ’s hex editor will destroy files.  Therefore, only use
this feature if you know exactly what you are doing.  Currently FileZ only allows for editing
database (record) files and not application (resource) files, although we will probably add this
functionality in the future.

You can edit files by tapping the Menu button, selecting the File menu, and then selecting Edit
while in the File List view.
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Q: I don’t see my external memory card in the list when I want to copy or move a file?

A: Each external memory card (Secure Digital/Multimedia Card/Compact Flash/Memory Stick)
has a name called a “label” or “volume label”.  If you do not see your card appear in the list
when copying/moving, please be sure your card has its label set.  You can do so by using a
utility program that came with your handheld (which program depends on which card/handheld
you have).

Q: Why did the size of FileZ increase so much after version 5?

A: The Hi-res feature of Palm OS 5 requires that applications use much higher-resolution
graphics, and hence, the graphics themselves are much larger and results in a larger .prc file.

Q: Why do I get an error when attempting to view the list of files on the Palmcard or on an
external memory card?

A: FileZ loads a good deal of information about each file while it is loading (when you see the
progress bar) to allow for filtering, etc.  During this process, FileZ performs all the checks that it
can to ensure that the information about each file is loaded properly.  If a file becomes corrupt,
the Palm OS API system call that opens a file may fail and result in a fatal error during the
loading process.  Since it is a Palm OS system call that is failing, there is no way for FileZ to
prevent the fatal error.  In this case, FileZ cannot be used unless the corrupted file is removed
or fixed.  We may add support in the future to detect and/or fix problematic files, but currently
FileZ does not do so.

Q: Can we expect to see support for Sony’s or Handera’s high resolution screens?

A: Palm OS 5 now has built-in hi-res support, and these manufacturers seem to be switching
over to use it rather than their own proprietary methods, we plan to only support Palm OS 5’s hi-
res.

Q: Why do I get a fatal error when I copy or move a file from a VFS card to the internal Palm
memory?

A: Once the file has been successfully copied/moved from a VFS card to the internal memory,
the owner application associated with the file’s type (i.e. the imported file itself if it’s an
executable, or the associated application if it is not) is sent a sysAppLaunchCmdSyncNotify
launch code to make it aware of the new database.  This can cause a fatal error under some
circumstances (not possible for us to catch).  Here’s how:

You have a program that needs a bunch of databases in order to run properly.  If you copy the
program over to the internal memory first, then when it receives the
sysAppLaunchCmdSyncNotify launch code, it will try to run, but since you haven’t copied all the
databases yet that the program needs, the program will cause a fatal error (although it’ll look
like FileZ caused it, when it didn’t).
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For Developers

Here is a description of what the attributes mean. Once again, only change these if you know
what you are doing and have a good reason to do so.

Internal Cards

App Info Dirty The application info block is dirty (has been modified since the last sync).
Backup DB The database should be backed up to the desktop computer if no

application-specific conduit is available.
Copy Protect Prevents the database from being beamed to another handheld using the

built-in beaming application.
OK Install Newer The backup conduit can install a newer version of this database with a

different name if the current database is open.  This mechanism is used to
update the Graffiti Shortcuts database, for example.

Read Only The database cannot be modified.
Resource DB The database contains resources, not just data records.
Reset After Install The device must be reset after this database is installed.  That is, the

HotSync application forces a reset after installing this database.
Stream The database is a file stream.
Hidden The application does not appear in the application list.
Launchable Data This database (not application) contains launchable data.

External Cards

Hidden This file does not appear in the launcher
Read Only This file is cannot be modified.
Link This file is a link to another file.
System This is a system file.
Archive This is an archive file.
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Revision History

Version 5.3 (12/10/03)
Bug fixes:

• fixed the "set all bits to x" to check for at least one selected file
• fixed the "too many files" error for devices with lots of files
• fixed 4-bit small application icon (beta 5)
• fixed file so that it overwrites any existing 5.22 version (beta 5)
• fixed problem with beaming from an external card (beta 3)
• corrected size display for files larger than 10mb (beta 2)
• fixed crash if you press ok without entering a name for a type color (beta 2)
• scroll bug in preferences list
• bug in displaying file sizes larger than 9999k
• dates and times shown in wrong format after changing them in file details
• when a file is checked, then the filter dialog is opened and cancelled, the file appears to

be checked but pressing the details button does not work
• on startup, properly restores FileZ to the last screen in use (main, list, info, or prefs)
• fixed the preference export for a single preference

Enhancements:
• for files on the internal memory card, the file details now show what the total size is of all

files with the same creator id. (beta 4)
• customizable file type colors for the file list view
• file sizes are now specified to one decimal point
• FileZ can automatically rename files that have invalid filenames when being copied to

external memory cards
• on startup, FileZ sets the current card to whatever was being viewed last
• added a new memory view state on the main menu
• on startup, FileZ remembers the last memory/batter view on the main menu

Internal:
• converted project over from CodeWarrior to Prc Tools
• started documenting the code to support doxygen automatic documentation
• reorganized and extended what preference info is saved

Version 5.2 (1/6/03)
Bug fixes:

• fixed bug in file editor when attempting to edit deleted records
• fixed a display bug in the hotsync info tab
• fixed beeping bug when scrolling the file list

Enhancements:
• added a preference editor

Version 5.1.1 (12/29/02)
Bug fixes:

• fixed bug in copying/moving files

Version 5.1 (12/27/02)
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Bug fixes:
• fixed filter bug in vfs file listings
• fixed the card list when copying/moving

Enhancements:
• updated the menu screen
• integrated the memory/hotsync/battery info into a single, tabbed form
• directory rename
• vfs file rename
• longer filename display in file detail screens
• palmos 5.0 high resolution graphics
• jogdial support
• rename file/directory support

Version 5.04 (9/13/02)
Bug Fixes:

• list Menu bug
• file selection bug
• others…

Enhancements:
• secondary PalmCard support

Version 5.0 Preview (9/3/02)
Enhancements:

• MemPlug support
• beam from VFS to Internal card
• view/sort by create/backup/mod date in list view

Version 5.0 Beta (8/10/02)
Enhancements:

• multiple file delete/copy/move
• substantially rewritten

Version 4.0.1 (1/21/02)
Bugs fixed:

• fixed last-byte-missing in hex editor
• fixed some hex chars being displayed incorrectly
• allows any character as input in the hex editor

Version 4.0 Final (1/15/02)
Enhancements:

• abiliy to edit files via a hex editor
• mem card to mem card file copying
• detailed memory card info available
• details hotsync info available

Version 3.01 (16 June 2001)
Enhancements:

• fixes for the VFS support
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Version 3.0 Beta (28 May 2001)
Enhancements:

• support for memory cards (SD, CF, etc)
• faster refresh after a file delete
• much faster filtering

Version 2.7 (4 May 2001)
Enhancements:

• second column can now also show record count and attributes
• can filter by record count and by attributes
• file dates can be set to “Never” and are handled more cleanly
• cooler progress bar while loading
• command bar support ( >= OS 3.5)

Version 2.6 (30 March 2001)
Enhancements:

• smarter list scrolling / selecting
• way cool progress bar when loading
• new system info screen (via menu)
• new menu options to set/unset all files’ backup and copy-protect bits
• improved memory display in list view; now shows used/available (%available)

Version 2.5 (20 March 2001) (version 2.4 not released)
Enhancements:

• much cooler file details screen and color support in the file listing
• can edit the create/modify/backup date/times for files
• can edit the version id of a file

Version 2.3 (13 February 2001)
Enhancements:

• faster loading of the list view
• 2nd column now settable to creator/type/size
• filter support added (thanks z’cat)
• free memory display in list view
• new hide rom files option
• memo pad export exports more info
• shortcut strokes recognized in list view
• added support for external files
• no separate developers version anymore

Version 2.2 (18 January 2001)
Enhancements:

• new backup icon in list view
• list now sorted by tapping on column names
• all attributes now supported
• record count and file size now included in file details
• scrollbar in list view & faster list drawing
• color support for icons in list view

Version 2.1 (25 November 2000)
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Enhancements:
• various sorting capabilities added
• icons to indicate attributes in main list
• export list to memo pad application capability

Bug fixes:
• read-only setting

Version 2.0 (3 October 2000)
Enhancements:

• details screen with ability to modify file flags

Version 1.1 (14 april 2000)
Enchancements:

• support for the hardware scroll buttons

Version 1.0 (8 april 2000)
Initial Release.
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Disclaimer

Despite our best efforts, bugs sometimes find their way into our software (and tell us if you find
any!) and sometimes you can do things that you don’t intend to that can mess things up, so
therefore we cannot take any responsibility for any loss of data or the like that may occur.  This
software is provided “as-is” without any warranties expressed or implied and by downloading the
software the user agrees with this and uses the software at their own risk.


